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Syllabus Plus 
Getting Started 

 

This Syllabus Plus training guide covers everything you need to know to get you started.  By the time you 
reach the end of this guide you will be able to: 

 Access Syllabus Plus (referred to throughout the guide as S+); 
 Navigate around the system; 
 Understand the terminology used in S+; 
 Update and delete activities; 
 Add activities using activity templates. 

If you have any questions when you have worked through the guide, please contact the Timetabling & 
Room Bookings Team on ext. 34009 or timetable@leeds.ac.uk. 
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Section 1: Accessing S+ 

Opening S+ for the first time 

You will need to have S+ installed on your PC before you can access it.  This is done remotely for 
schools/departments – email itservicedesk@leeds.ac.uk to request the software be installed on your PC.  
You will need to ask for the most up-to-date version, together with the license file, and include the 
REGXP number of your PC in your request – there should be a sticker on the side of your PC displaying 
the REGXP number or go to http://mypc.leeds.ac.uk/. 

When you access S+ for the first time, you will need to retrieve an “image”.  This is a copy of the database 
which is stored on your PC and updates each time you connect to S+. This image refreshes from the 
server whilst ever you are connected to it, all the time keeping you in sync with the central database.   

The image can be found under the Timetable downloads section of the SES website: 
http://ses.leeds.ac.uk/info/21630/timetabling/890/timetabling_reference_materials. 

1. Click on the relevant academic year’s Image file.  The image is compressed into a zip file to 
speed up the download to your PC. For example, clicking on the 1516 image file will display 
the screen below:  
 

 
 
2. When prompted, choose to ‘open’ the zipped file.   

 
 

3. Right click on the image file in the folder and select either ‘cut’ or ‘copy’. 

 
4. Select a suitable place on your PC and paste this file into it.  We recommend creating a folder 

such as c:\Splus backup.  However, this may depend on your PC settings and you might not be 
able to save to your c:drive.  In this case we recommend that you save to another hard disk 
drive, designated “local disk” or to your desktop.  (NB avoid saving your image to a network 
drive as this may slow down the performance of the software.) 

 
5. You can now start S+.  Go to Start>Programs>Scientia>Syllabus Plus 3.10.0.9>Syllabus Plus.  

This opens the ‘Select an image file to open’ window: 

itservicedesk@leeds.ac.uk
http://mypc.leeds.ac.uk/
http://ses.leeds.ac.uk/info/21630/timetabling/890/timetabling_reference_materials
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6. Either double-click the 1516 image file (or whichever image you wish to open) - if it is displayed 
in the screen - or browse to where you have just saved the image, select and click ok. 

 
7. The image file will now open. 

 
8. Click Connect 

 
 

9. Enter your S+ username and password – you will need to overtype the ‘splus’ in the username 
box on the screen.  If you don’t know your username and password, please contact the 
Timetabling & Room Bookings Team as it will not be the same as your IT username and 
password.   
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10. Click Connect again. 

 
 
 

11. The image will then be refreshed with the data that has been saved to the server since the 
last time you used it.  The length of time this takes will depend on the amount of data.  If you  
don’t use S+ regularly or it is a while since you last used it, we recommend that you get a new 
zipped file from the website and save it to your PC as there may be too much data to refresh. 
While the image is refreshing, the screen will display Refreshing from SDB, as shown below.  
The system is still working while the yellow box (circled below) remains yellow.  Once this 
box becomes red, it means the image is fully refreshed and ready to use. 
 

    
  

12. You should then save the image before continuing.  Go to the File drop-down menu and 
select Save as… which opens the Save File window 
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13. Leave the format as Image and click Browse… to specify the filename.  You cannot save the 
image to the filename given here, i.e. c:\s+images\1516.img.  If you have saved to the c:drive 
then the filename will be: c:\Splus backup\1516.img 
 

 
 

14. Click Save. 

     
15. S+ will then close and re-open.  Click Connect to start working. 

   
16. S+ is now ready to use. 

 

Opening a saved image 

1. Next time you log into S+, open it by selecting it from the Programs list, or by double-
clicking the icon on your Desktop. 

2. S+ will ask you to select an image file: 

 

3. If the image that you have previously saved appears in this box, click on it then click on 
OK to open it. 

4. If the name of the image doesn’t appear in the list, click on the Browse… button, open 
the directory where you have saved the image, and click OK when you have selected the 
correct file. 
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5. You will then be asked for your password.  Once you have entered it and clicked OK, S+ 
will then “refresh” from the server and you can continue to work on that image.  When 
S+ automatically refreshes from the server, all the data changes which have occurred 
since the last refresh are downloaded to your PC.  This means you are always looking at 
the current version of the data while connected to the server. 

 

 

Section 2: Finding your way around Syllabus Plus (S+) 

Saving your work 

1. S+ has two types of Save: Modify and Write-back:  

 

 

2. When working on S+ you should click Modify each time you make a change – this saves the 
changes locally to your PC and only you can see them. 

3. When you are sure that you want to keep the changes you’ve made, use Write-back (the WB 
button at the bottom of the screen) to save the changes to the server.  The changes will be 
permanent and other users of the database will be able to see them.  It is advisable to write-back 
frequently when you are sure you want to keep any changes that you have made.  This means 
that you will not need to repeat work if you make a change that you need to discard or you have 
to unexpectedly close down your PC. 

4. If you do make a change that you don’t want to keep, e.g. if you delete an activity by mistake, 
click on the cross in the top right-hand corner of the screen to close S+.  Choose Discard when 
asked if you want to save changes to your image, and No when asked if you want to write-back.  
S+ will then close and you can simply re-login to continue working from the stage where you last 
clicked WB.  However, S+ cannot distinguish between work you want to keep and that which you 
want to discard so it is strongly recommended that you write-back every time you want to keep 
something you have done. 

5. If you change something on the screen and realise it is wrong before you click Modify, click 
Refresh – this will change the screen back to its original values:  
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6. If you want to explore the database and be confident that you will not save your changes by 
accident, click Dis.  This disconnects you from the database so that you cannot write-back.  When 
you are ready to re-connect, click Con – the changes you made whilst disconnected will still be 
waiting to be written back.  If you have made changes that you don’t want to keep, make sure 
that you exit S+ without writing back, as described in point 4 above.   

 

 

7. S+ refreshes automatically – the default time period is once per minute.  This period can be 
changed, by clicking on RO (i.e. “Refresh options”), although it is unlikely that you’ll need to.   It is 
also possible to refresh your image manually by clicking on Ref.  This is useful if someone else has 
written back a change that needs to be displayed on your screen straightaway. 

 

Using the menus 

 

1. The main menus that you will use are circled above. 

Timetabler is used to access the different areas of the system.  Clicking on Timetabler will show 
the different options available in a drop-down menu.  This is your starting point to view 
Programmes of Study and Modules, and to start adding and editing the Activities that make up 
your timetable. 

Windows allows you to switch between the different screens you have open, for example if you 
have two or more screens open and want to return to one “hidden” behind the one at the front.  
This menu also allows you to open additional screens, for example, if you a viewing an Activity 
screen and want to open a second to cross-check the details, click Windows followed by New 
Activity Window from the drop-down menu. 

View gives you access to the Filter and Browse functions. 
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Filtering 

1. In an Activity screen you might want to see only those activities related to your department, for 
example.  Click View then select Filter from the drop-down menu. 

2. Select Department from the Filter Activities by list, choose your department from the Objects list 
and click Filter.   In the example shown below, we are choosing to view all activities belonging to 
Classics.  

 

3. In the top right of the Filter window, you can choose to filter by whether activities are scheduled 
or not. 

4. There is also a Week pattern bar across the bottom of this window.  If you wish to filter activities 
to include only those which occur in a specific week or weeks, click the check box on the left and 
then select the relevant week(s).  To select multiple weeks (for example, you might want to 
select all Semester 1 weeks) hold down the Ctrl key on your keyboard whilst clicking the boxes:  

  

5. You can also filter using criteria from another screen in S+.  For example, you might want to find 
all the activities from your school which are booked into Central Teaching Space rooms. 
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6. Open an Activities screen (select Activities from the Timetabler menu) and select Filter from the 
View menu. 

7. Filter activities by your department – in this example, we are using Classics.  Select the 
department in the Objects box followed by Filter: 

 

8. Press Ctrl & A on your keyboard to select all the activities in the list: 

 

 

9.  Select Locations from the Timetabler menu to open a locations window. 

10. Select Filter from the View menu and filter locations by the department Central Teaching Space, as 
shown below.  Click Filter.   
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11.  Press Ctrl and A on your keyboard to select all items in the Locations list. 

12. Go to the Windows menu on your toolbar and select the item “Activities – filtered by 
Departments” (this will be your department, in this example Classics).  This will bring the 
Activities window back to the front of the screen, with all the items still selected. 

13.  Select Filter from the View menu (to open the Filter window) and click the From Window… 
button on the left (circled below).  This will open a Filter from window. 

  

  

14.  In the Filter from window, select Locations – filtered by Department (Central Teaching Space) in 
the list then click the Selected button.  This tells S+ to filter by the objects you have highlighted in 
the Locations screen.  Click Filter. 
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15.  You will now see a list of all activities allocated to Central Teaching Space locations.  The 
activities in your department will still be highlighted in the list.  To view these activities only, 
select Filter from the View menu, and click the From Window… button again. 

16.  This time, select the item which says Activities – filtered by Locations… and click Selected, 
followed by Filter. 

17. A list of your activities which are allocated to Central Teaching Space rooms will then be 
displayed. 

18. You can select Filter from the View menu and click Unfilter to remove all filters at any time. 

19. You can also double filter a screen by two criteria.  Simply filter by the first one, press Ctrl and A 
to select all, filter by the second, and then filter From Window… and Selected to reduce the list. 

Please note – you will find more information about filters in the “Complex filters” manual which 
can be found in the “Syllabus Plus Training Materials” section of the SES website: 
http://ses.leeds.ac.uk/info/21630/timetabling/911/syllabus_plus_training_materials. 

 

Browsing 

1. The View menu also contains the Browse command.  When viewing in normal mode, screens 
show all available options, with selections highlighted in blue:  

 

2. When you choose the Browse option (or press Ctrl and B on your keyboard), S+ displays only the 
options that have been selected:  

http://ses.leeds.ac.uk/info/21630/timetabling/911/syllabus_plus_training_materials
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3. This can make it easier to see what has been selected.  However, you cannot make any changes in 
this mode so you will need to exit Browse mode by selecting it again from the View drop-down 
menu (or Ctrl & B) to return to Normal mode to make your changes. 

 

 

 

Section 3: S+ Terminology 

This section contains details of the terminology used in S+. 

Programme of study 
The highest level of course data.  Information about Programmes of Study is taken from Banner.  If out-
of-date programme information appears in S+, or new programmes don’t appear, check that Banner 
information is correct.  Programmes of study cannot be edited in S+. 

Module   
Units of study that combine to form a Programme of Study.  Again, information about modules and the 
students enrolled on particular modules is taken from Banner – it must be correct in Banner to show 
correctly on S+.  Modules cannot be edited in S+. 

Activity  
The learning events that make up a module.  These include lectures, seminars, tutorials, practicals and 
any other learning event. 

Activity Template 
Used to generate the correct number of activities for a module depending on the number of students 
enrolled, and to allocate students to their groups.  If an activity isn’t generated from a template, students 
can’t be allocated to the activity. 

Tabs 
Each screen in S+ has a number of tabs across the top as indicated below.  Clicking on these allows you to 
access different parts of the screen.   
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Suitabilities 
Used to specify the characteristics of resources required for activities, including equipment, room types 
and zones (see below).  These can apply to locations, staff and equipment.  Suitabilities are selected on 
the Resources tab of your activity.  To make multiple selections, hold down your Ctrl key on your 
keyboard, ensuring that you click Modify after making your choices.  It is very important that you 
remember to hold down your Ctrl key whenever you need to select more than one item from a list.  If an 
item is already selected and you click on another without using the Ctrl key, you will lose your original 
selection. 

Zone Suitabilities  
Each school has specified a zone which contains the names of centrally-owned teaching rooms that they 
prefer to use.  If you need to request Central Teaching Space for your school’s activities, select your 
school’s zone from Location Suitabilities to state your preference for those rooms.  If you are using your 
school-owned rooms, these can be added to S+ and a school-owned zone created.  This would appear in 
the Resources list as, for example, ZONE ENGL (SO) which includes only those rooms owned by the School 
of English and which can be used only by them.  If you have school-owned rooms which are not included 
in S+ and you would like them to be, please contact the Timetabling & Room Bookings Team.  This will 
allow the room to appear on the timetable.  The only zones used are those found within the Suitabilities 
list on the Resources tab.  We do not use the Zone drop-down list.  If selecting zones, please select a 
ZONE item within the Suitabilities field.   

Please note that allocation to centrally-owned rooms is now partly automated.  You will 
therefore need to ensure that you have selected the room type and zone suitabilities at the 
absolute minimum when your data is submitted in May.  Failing to do so could result in the 
wrong type of room in an area of campus not preferred by your school or department being 
allocated. 

 

 

Section 4: Creating Activities 

How are modules structured? 

If the activity you need to work on is not already in the Activity list, you will need to create one.  This 
should be done from an Activity Template.   

Activity templates are designed to save time in creating activities by: 

 Automatically generating enough activities to provide spaces for all of the students expected on 
the module, depending on the group size specified. 
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 Allowing you to update all of the activities related to a template without changing each activity 
individually. 

 Automatically linking students to the template if they are linked to the module, and showing 

timetable clashes at a glance once the students have been allocated. 

 Giving a quick and easy method of allocating students to specific activities, providing a 
personalised timetable for students. 

Activity Templates set out the structure of the module.  Linked activities, such as seminars and lectures 
are then created, and these are the actual teaching events which will appear on the timetable. 

 

To work out how many activity templates you need, consider the structure of your module.  For example, 
a module may have 80 enrolled students.  Each week the students should attend two lectures and one 
practical.  You would therefore need three activity templates: 

I. A lecture template with a planned size of 80 students – 1 activity required 

II. A second lecture template with a planned size of 80 students – 1 activity required 

III. A practical template with a planned size of 20 students – S+ will then calculate that four practicals 
are required in order to fit all the students into a group. 

By creating these templates, you are telling S+ that each student enrolled in the module must attend one 
activity from each template. 

 

Creating an Activity Template 

1. If the activity you wish to timetable is not in S+, you should create an activity template to 
generate it.  In S+ go to the Timetabler drop-down menu and select Activity Templates to open 
an activity template screen. 

2. Before you create a template, check that the appropriate template linked to that module doesn’t 

already exist by checking the list on the left of the screen. 

3. Clear the screen of any existing data to create a new template.  To do this, look at the bottom 
right of the Activity Template window.  If a New button is visible (circled below), you are ready to 



Syllabus Plus: Getting Started 
 

Timetabling & Room Bookings  
Version 1.5 December 2015 Page 16 
 

create a template.  If the same button is labelled Duplicate, this means that a template is selected 
in the list.   To deselect it, hold down the Ctrl key and click on the selected template.  The New 
button will then become available. 

 

 

4. When the New button is visible, you can enter the details of your new template on the ID tab: 

Name 
The format of the template name should be module code/activity type – for example, if you 
are creating a template for the seminar sessions in module ENGL125001, the name would be 
ENGL125001/SMR 1.  This naming convention will then be carried forward to all activities 

created through the template. 

Module  
Select the related module from the list to the top right of the screen.  S+ will then link the 
template automatically to the correct department when the record is saved.  It is essential 
that the correct module is selected from the list otherwise students will see an incorrect 
timetable. 

Description  
This field does not appear on the online timetables so it can be left blank.  However, you may 
find it useful to enter either the actual title of the module, e.g. “American Foreign Policy”, or 
the type of activity, e.g. “Lecture” or “Seminar”. 

Planned size 
This should be the estimated size of each group – i.e. if you plan to have 80 students split 
over 4 groups, the planned size is 20. 

Type  
This is the type of activity.  Ensure that you select the correct one from the list as this 
appears on the timetable.  If you need students to attend two or more of one type of activity 
each week – for example, two lectures – you will need to choose different activity types, i.e. 
LEC 1 and LEC 2, etc.  This helps to distinguish between the lectures on the timetable. 

Duration  
Specify the duration of the activity – a duration of 1 is 30 minutes in S+. 

Suggested day & time  
You don’t need to set these in the template. 

5. Click New to save the record. 

6. Click on the User Text & Tags tab.  If you have been informed that student allocations for this set 
of activities are to be done manually, select the “Preset Student Allocation” tag, as shown below, 
and click Modify:  
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7. Click on the Availability tab.  This is where you specify the weeks in which the activities related to 
the template will be taught.  If the activity is due to run for a whole semester or across both 
semesters, you should use a Named Availability, i.e. a preset week pattern.    Alternatively, the 
appropriate weeks can be selected in the Teaching Week Pattern bar across the top of the 
screen. 

8. To select a Named Availability, click on the appropriate name in the list, as circled below.  When 
you click on an item, the related week pattern is shown in the Teaching Week Pattern bar – check 
that this is correct, and, if so, click Modify.  (SEM 3 means an activity will take place in all weeks in 
both semesters 1 & 2.)  

 

 

9. If you want to specify your own availability pattern, ensure that [None] is selected in the Named 
Availability box.  Hold down the Ctrl key and click in each week (in the top row - i.e. Teaching 
Week Pattern) in which the activity should take place.  Click Modify when you have finished.  If 
you wish to select a named availability and then adjust the weeks selected, you must first select 
the relevant named availability, click Modify, and then select [None] from the top of the Named 
Availability list.  Once you have done this, hold down the Ctrl key and click on the relevant 
squares in the Week Pattern bar to add or remove weeks. 

10. If you are trying to change the week pattern and S+ isn’t allowing it, check that you are selecting 
weeks that fall within the teaching pattern specified in the module.  To do this, double-click on 
the module name in the top right of the screen.  This opens a module screen and you can view 
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the Teaching Pattern on the ID tab.  For example, S+ will not let you schedule an activity in 
semester 1 if the module information states that it is a semester 2 module.  If the teaching week 
pattern in the module is incorrect, this will need to be updated in Banner in order to feed 
through to S+. 

11. All activities generated from the template will then have the same week pattern.  However, if the 
activities that you generate from a template should not have the same week pattern, you do not 
need to specify the week pattern here.  Instead you can set the week patterns on the Availability 
tab of each individual activity. 

12. The activity template is then complete.  If the details are correct, click WB to commit the changes 
to the database. 

 

Generating Activities from Activity Templates 

1. Once you have created your activity template, you can then use it to generate your activities for 
the module. 

2. Make sure that the correct template is selected from the list on the left of the screen and click on 
the Planning tab 

  

3. At the top of this tab (circled above), S+ calculates how many activities you need to create in 
order to accommodate all of the students who are taking this module.  In this example, the 
planned module size is 61 students, and the planned group size for this seminar activity is 15.  As 
there are no existing activities on the system for this template, S+ has calculated that 5 seminars 
are required to allow all students to be allocated to a group. 

4. If the number is correct, click Generate and S+ will create that number of activities.  If you wish to 
create a different number of activities, click Make Activities… instead and specify the number 
required. 

5. The names of the activities you have generated will then be displayed on the screen.  Please note 
that the activities inherit the name of the activity template plus the group number (i.e. 01, 02, 
etc.) so it is very important that this is correct. 
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6. Click WB to save your changes so far to the database. 

7. You will now need to edit each activity individually.  On the Planning tab, double-click on an 
activity name to open the activity screen.  The following section (“Scheduling the Activity”) gives 
the process in detail. 

 

Scheduling the Activity 

1. When scheduling an activity, it is recommended that you start on the ID tab, on the left, and work 
across the tabs from left to right.  This will help you to remember to enter all required details. 

2. On the ID tab you should check the Size (plan), Type and Duration fields are all correct.  Click 
Modify if you make any changes although they should be correct as they have been pulled 
through from the Activity Template if they have been set there. 

3. If you know the day and time of the activity, enter it in the Suggested Day and Suggested Time (as 
indicated below) and click Modify  
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4. Click on the User Text & Tags tab.  If you want to request Central Teaching Space, including IT 
clusters, for the activity, select Requires CTS in the Tags field, as shown below.  Please note – this 
is very important as, without this tag, a room will not be allocated.  

 

5. Hold down the Ctrl key while selecting the tag if other tags have already been added to the 
activity.  If you forget to hold down the Ctrl key, and lose the previous selections, do not click 
Modify!  Click the Refresh button and the original selections will be displayed on the screen.  You 
can then hold down the Ctrl key, and add your tag. 

6. Click Modify to save your changes. 

7. Click on the Resource tab 

 

8. On this screen you can specify your Staff, Location and Equipment requirements. 

9. To select a specific member of staff, click on their name in the Staff list in the bottom left column.  
Click Modify to save. 

10. Locations are specified in the central column 

 To allocate a school-owned room 
If any of your school-owned rooms are large enough for the class size specified, you should 
select ZONE [school name] (SO) from the suitabilities list in the top half of the central 
column.  The names will appear beneath, and you can select a specific room.  If the room you 
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want isn’t in S+, please contact the Timetabling & Room Bookings Team and we can add it for 
you. 

 To request Central Teaching Space 
Ensure that the drop-down list on the Locations column is set to None (if the drop-down list 
is set to Wildcard, you will need to change it to None otherwise you will allocate a room), and 
select the suitabilities you require from the top half of the column.  If you want to choose 
more than one item from the list, hold down the Ctrl key whilst making your selections.   
Suitabilities are the characteristics of a location, and should be used to specify your 
requirements for each activity.  Please ensure that you select only those suitabilities that are 
genuinely required – selecting lots of items on a “just in case” basis will limit the number of 
rooms from which the Timetabling & Room Bookings Team can allocate.  There are 3 key 
categories of suitability: EQP (equipment in a room, e.g. Acetate projector, chalkboard, etc.); 
TYPE (room type, e.g. lecture theatre, flat-floored room, etc.); ZONE (preferred campus area 
– ensure you specify the correct zone for your school).   All centrally-owned rooms are 
equipped with a PC and computer projection.  It is vital that you find out teaching 
requirements from academic staff and enter this into S+ prior to the start of room allocation 
– otherwise it is possible that the room allocated will not have the required facilities.  Please 
don’t make assumptions about what comprises “standard equipment”.  As the room 
allocation is now partly automated you will need to select TYPE & ZONE as an absolute 
minimum.  If allocating a school-owned room, you don’t need to make selections in this 
column, other than the room itself.   

11.  When central room allocations are done, a room will be allocated based on the data entered 
here and if you have requested Central Teaching Space. 

Important – you must not allocate a Central Teaching Space room to your own activities.  Room 
allocation follows a strict procedure! 

12.  The Equipment column on the right is only used for specialist items particularly related to dental 
and medical courses.    

13. Once you have made all your choices with regard to location, ensure that you have clicked Modify 
before moving on to the Availability tab. 

14. This tab is used to specify the weeks in which the activity takes place  

 

15. If you set the week pattern in the template these details will have been pulled through.  
However, if the week pattern is not the same for all activities attached to the template, you will 
need to specify it here. 

16. The Availability screen on the activity works in exactly the same way as in the template.  You can 
either select a Named Availability from the list on the left (which is preferred if one exists for the 
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relevant week pattern), or ensure that Named Availability is set to [none] and click in the boxes 
on the Teaching Week Pattern bar to specify your own pattern.  Click Modify to save.  If you 
frequently use a particular non-standard week pattern and would like to use a preset Named 
Availability, contact the Timetabling & Room Bookings Team and this can be set up for you. 

17. Click the Timetable tab, and click into one of the grey boxes in the week pattern bar across the 
top – the grey boxes indicate the weeks in which the activity is set to run.  

 

 

 

18. If there are no clashes on the timetable, you will see a yellow diamond on the grid (as shown 
above) at the suggested day and time you have entered.  Simply click Schedule and the event will 
be added to the timetable.  

 

 

19. As long as you are happy with your work, click the WB button to commit your changes to the 
database.  This will allow other users to see the information immediately. 

20. If the yellow diamond doesn’t appear on the screen, first check that you have selected one of the 
grey boxes in the Week Pattern bar.  If not, click on one of the grey boxes to select it. 



Syllabus Plus: Getting Started 
 

Timetabling & Room Bookings  
Version 1.5 December 2015 Page 23 
 

21. If the diamond still doesn’t show, this means there is a clash for one of your resources.  Click on 
the box for the suggested day and start time that you have specified, and look at the bottom of 
the screen.  The notes there will tell you with which resource you have a problem. 

 

 

22. In this example, there is no location available.  Return to the Resource tab and check that you 
have selected None in the location column, or that you have selected the correct school-owned 
room.  Once you have modified any changes, you should then be able to schedule your activity. 

23. Depending on when you are creating activities, you may not be able to schedule an activity due 
to the pathway planning or because students are allocated to it.  You might not be able to 
schedule the activity because it would cause a clash for one of the compulsory elements of a 
programme.  If this is the case, you will see on the screen which activities would clash.  The clash 
must be resolved before the activity is scheduled.  If the clash is between two activities in your 
school, you must find an alternative timeslot for one of the activities (see next section).  If the 
clash is with another school’s activity, please contact the Timetabling & Room Bookings Team. 

24. If you are scheduling an activity to run for more than one day (e.g. to schedule a week-long 
module which has the same length lecture each day in the week), simply select all of the days you 
need on the ID tab.  You will then see a yellow diamond together with some blue diamonds on 
the Timetable tab.  Click schedule and the activity will be scheduled on all of the days you have 
selected. 

25. If the activity has previously been scheduled for the wrong time, click Unschedule to remove it 
from the timetable.  You will need to amend the day/time on the ID tab.  S+ will then display a 
yellow diamond to indicate availability, and you can click Schedule to put the activity into the 
correct place in the timetable. 

26. If an activity appears to have a clash, but you don’t think it should, check that the week pattern is 
correct – if week patterns overlap for even one week when the activities are at the same time, S+ 
sees this as a clash and will not allow you to schedule. 
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Jointly-taught activities 

 You may be asked to schedule at the same time two or more activities which are taught by the 
same person and for which one room is required.  It isn’t possible to double-book the room so you’ll need 
to contact the Timetabling & Room Bookings Team to ask for a jointly-taught activity (or JA) to be 
created. 

 You’ll need to set up the activities first (they may already be in S+; generating them from 
templates if not).  The activities will need to be identical in terms of  

 Day 

 Time 

 Duration 

 Week pattern. 

JAs are carried forward from one year to the next so you’ll need to let us know if there are any 
changes. 

Once a JA has been created the individual activities (the parent activities) which make up the JA 
cannot be amended in any way – any changes need to be made to the JA. 

As JAs are created in Enterprise, changes to week patterns also need to be made in Enterprise –
contact the Timetabling & Room Bookings Team.  All other changes can be made in the usual 
way. 

 

Variant activities 

 Occasionally a class needs to be rearranged, different staff are teaching across the semester or a 
different room is being used in some of the weeks.  Rather than creating separate activities you can 
contact the Timetabling & Room Bookings Team to ask for a variant to be created.  This will appear on the 
timetable and you don’t need to worry about copying student allocation. 

 Once a variant has been created the original activity (the parent) cannot be amended in any way 
– any changes need to be made to the variant. 

 Changes to the week pattern of a variant need to be made in Enterprise – please contact the 
Timetabling & Room Bookings Team.  All other changes can be made in the usual way. 

 

Section 5: Finding new timeslots for activities 

If a clash occurs between two compulsory elements of a programme, you can use S+ to identify timeslots 
to which the activity could be moved without causing further clashes. 

1. Before you start, click WB to ensure that all changes up to this point are saved.  This allows you to 
close S+ without saving if you make changes here that you don’t wish to keep. 

2. Make sure that you have the Activity screen open (NOT Activity Template), and that you have 
selected the correct activity. 
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3. If you are looking for a new timeslot early in the scheduling process (i.e. before the Timetabling & 
Room Bookings Team has begun allocating rooms), you only need to take locations into 
consideration if you want to use a school-owned room for the activity.  If this is the case, click the 
Resource tab and make sure that the room you want is selected or, if you want S+ to check all 
your school-owned rooms, select the suitability relating to your school, e.g. ZONE LUBS (SO), 
from the list in the top half of the Location column.  The (SO) indicates school-owned – if you 
don’t have this suitability set up for your school and would like to be able to use this method of 
identifying your school-owned rooms, contact the Timetabling & Room Bookings Team.  These 
rooms can then be allocated to your teaching activities and will appear on the timetable – only 
you will be able to allocate to them! 

4. If it is essential that a specific school-owned room is used for an activity, leave the drop-down 
menu at the top of the Location column set to Preset. 

5. If you are requesting Central Teaching Space for the activity make sure that None is selected at 
the top of the Location column. 

6. Click the Timetable tab and make sure that you have selected a week in which the activity is 

scheduled.    

7. The Timetable grid will be displayed as shown:  

 

 

 

8. The red bar represents an activity constraint.  If the red bar is the only constraint that appears in 
one box of the timetable, you will be able to reschedule the activity to that time – staff, location 
& students will all be available.  You will need to amend the scheduled day & time to the new 
requirements (on the ID tab). 

9. Go back to the Timetable tab.  You should see a yellow diamond in the new timeslot.  If so, click 
Unschedule and then Schedule (you can also drag and drop the activity to the new timeslot). 

10. If you have preset a school-owned room and there are boxes in the timetable with a pink bar, this 
means that the school-owned room isn’t available at those times.  In this instance, you could 
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move an activity to that time and request a Central Teaching Space room by adding the required 
suitabilities and requires CTS tag. 

11. You can also see where there are staff (light blue) and student (dark blue) constraints.  However, 
this can only be used for checking staff and/or student availability if they have been allocated to the 
relevant activities in S+. 

12. If you want a reminder of what the colours mean when you are in S+, go to the Format button on 
the Timetable tab to open the Timetable Grid Format box: 

 

 

 

PLEASE NOTE: if you are checking for available timeslots after room allocations have been done, and 
you will be requesting Central Teaching Space for the activity, please contact the Timetabling & Room 
Bookings Team before rescheduling the activity so that we can check that a room is available.  Please 
do not allocate your activity to a Central Teaching Space room without prior permission, or it may be 
unallocated.  If you want to check for availability and request a particular room, that is fine, but do 

not write-back your work with the activity scheduled into the room. 



Syllabus Plus: Getting Started 
 

Timetabling & Room Bookings  
Version 1.5 December 2015 Page 27 
 

Section 6: Updating Activities 

You will find that the majority of activities for the new timetable, including jointly taught activities, are 
already in S+ as they are carried forward from year to year.  All activities are unscheduled in S+ when you 
start updating your timetable information.  The specified times and suitabilities selected in the previous 
year will remain on the activity record, and week patterns should be the same.  Where variants have 
been created to accommodate different rooms or times, these will be deleted and the full semester 

activity reinstated. 

Removing Activities from the Timetable 

1. If an activity which ran last year is no longer running, you can either leave it unscheduled or 
delete it.  If the structure of your programme has changed and the activity is no longer required 
then you can delete it.  If you are likely to use the activity again, you may wish to unschedule it so 
that it remains on the system for future years. 

2. To delete an activity, open an Activities window from the Timetabler drop-down menu. 

3. Select the relevant activity by clicking on it in the list on the left-hand side of the screen.  Press 
the Delete key on your keyboard.  You will then be asked to confirm – click Yes to continue, or No 
to cancel.  If you delete an activity by mistake, remember that you can exit S+ without writing 
back and it will be reinstated. 

4. If an activity is scheduled, and you wish to unschedule it without deleting it, select the Activity 
and go to the Timetable tab.  Click the Unschedule button:  

  

 

5. You don’t need to click Modify for this change, but remember to write-back the change once you 
have checked it is correct. 

 

Checking and Correcting Activities 

1. When checking and rescheduling activities, you should start by checking the Activity Template. 

2. Select Activity Templates from the Timetabler drop-down menu to open a template screen. 

3. Filter the templates list by Department. 

4. Find template linked to the module you are working on in the list on the left of the screen, and 
click to select it. 
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5. Go to the Planning tab and check the names of the activities attached to the template (circled 
below):  

 

6. When student allocation is carried out, students will be divided between all activities attached to 
this template.  Check that the activities are linked together correctly, i.e. are on the correct 
template.  If they are incorrectly linked, email timetable@leeds.ac.uk, giving the name of the 
template and the activities, and ask for them to be split onto separate templates. 

7. Check that you have enough activities on the template.  If not, click on Make activities (circled 
above) and specify the number of activities you want to create.   You should only create activities 
this way if you want to link them to the existing template.  If you will need to allocate individual 
students to more than one of the activities, you will need a separate template. 

8. Double-click on the name of the activity on the Planning tab to open an Activity screen – the 
correct activity should be selected for you.  If, at any time, you want to return to the activity 
template, go to the Delivery tab and double-click on the name of the activity template, which can 
be found in the top left of the screen.  Do not click the Unlink Template button, as this removes 
the activity from its template and will cause problems with student allocation. 

9. As described in the section on creating activities, work through the activity, checking: 

 ID Tab: Name, Size (plan), type, duration, Suggested Day & Suggested Time (if the type is 
incorrect, check the template as this is where the ‘type’ on the online timetable is drawn 
from). 

 User Text & Tags: Requires CTS tag selected if requesting Central Teaching Space. 

 Resource: member of staff selected, and either school-owned room allocated or suitabilities 
selected for location. 

 Availability: correct teaching week pattern is selected. 

10. Once you have checked all of these details go to the Timetable tab and schedule the activity.  
Each activity will need to be scheduled individually.  However, they remain linked through the 
activity template, and the Timetable tab on the activity template screen will show all of the 
scheduled activities.  If you make any changes to the activity template, e.g. if you change the 
duration on the template, all related activities should be updated.  However, it is recommended 
that you also check the individual activities. 

mailto:timetable@leeds.ac.uk
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11. When you have scheduled this activity, you will be able to find the other activities for the 
template in the list on the left of the screen.  Click on the name of one to edit it, working through 
the checklist above. 

 

 

Section 7: Allocating Students to Activities 

Students must be allocated to their specific activities in S+ in order to provide them with an accurate 
personalised timetable.  The majority of student allocation will be done and updated centrally, but you 
will need to keep allocations up to date in two areas: 

1. Manual allocations – where the tutor has specified that group allocations must be done manually 
for academic reasons, it will be your responsibility to update these in S+, and to make sure that 
they are kept up to date when students change modules.  You will need to ensure that the Preset 
Student Allocation tag is selected on the Activity Template.  You can carry out a filter to find the 
templates which have students to be manually allocated (see below). 

2. Requested group changes – where students have been allocated automatically to groups and 
then request a specific change to another group, you will need to update these in S+. 

3. Prior to starting student allocation, make sure that the Planned size field in your activities does 
not have the real box ticked.  If this box is ticked, S+ will not allow students to be allocated to the 
activity.  The real checkbox can be useful if you want to know exactly how many students are 
allocated to an activity, but it shouldn’t be left ticked.  

 

 

Manual allocations 
To find templates which need to be manually allocated, you will need to carry out a filter.  You should 
already have tagged the relevant templates with Preset student allocation. 

1. Select Activity Templates from the Timetabler menu to open a window. 

2. Select Filter from the View menu, and filter to show only the templates belonging to your 
department. 

3. Press Ctrl + A on your keyboard to select all the items in the list. 

4. Select Filter from the View menu. 
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5. Select Tag from the Filter Activity Templates by… drop-down list, then select Preset Student 
Allocation in the Objects box. 

 

6. Click Filter. 

7. Select Filter from the View menu again, and click the From Window… button. 

8. In the pop-up list, click on Activity Templates – filtered by Tags (Preset Student Allocation). 

9. Click the Selected button in the bottom left of the screen 

 

10. Click Filter. 

11. You are now viewing all Activity Templates from your department which require manual 
allocation. 

12. If you want to narrow this down to find the templates with students who have not yet been 
allocated, click the ID tab of the Activity Template you are viewing. 

13. Click the Select… button in the bottom left of the screen. 
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14. Select Unallocated Student Sets and click OK. 

 

15. All relevant templates will be highlighted in the resulting list.  Select Filter from the View menu 
again, and click the From Window… button. 

16. In the list, click on Activity Templates – filtered by Activity Templates (…). 

17. Click the Selected button in the bottom left. 

18. Click Filter. 

19. You have now isolated the Activity Templates which need to be updated. 

20. Click on the first one in your list, and go to the Allocate tab. 

21. You will see a list of student sets on the left of the screen – these are in the format Surname, First 
Initials, (Student ID number). 

 

22. Each column represents an activity.  For each student (in this example, the programme pathways 
are shown, rather than students), double click in the column representing the group to which you 
want them to be allocated. 
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23. The student name/number will change from bold to normal text and a tick will appear in the 
relevant activity column. 

   

24. Scroll down the list of students to ensure they are all allocated. 

25. If a grey box appears in a column, this means that the student is already allocated to another 
activity at this time.  You will therefore have to allocate the student to another group.  If you 
need to check which activity is blocking the allocation, double-click on the student’s name to 
open the Student Set screen.  Go to the Timetable tab and check the relevant timeslot.  If the 
“blocking” activity is one where alternative timeslots are available, it may be possible for the 
student to change groups in order to accommodate the activity you trying to allocate.  This 
should be done in consultation with the student if teaching has already begun. 

26. Make sure you write-back your changes when you have finished. 

Group change  
1. Select Activity Templates from the Timetabler menu. 

2. In the list on the left, find the activity template that will be affected by the change, and click on 
the name. 

3. Go to the Allocate tab. 

4. Find the student’s name in the list.  If they do not have a grey box in the column for the group 
they wish to move into, simply double-click in the box to carry out the change.  If they do have a 
blocking activity, you should investigate it as described in point 25 above. 

5. Make sure you write-back the change when you have made it. 

S+ will allow you to overload a group (this is indicated by an exclamation mark on a yellow background at 
the bottom of the column), but this isn’t recommended, particularly if room allocation is underway. 

 

If you find that you need to overload one or more groups, you should try the following solutions: 

1. Move other students into different groups to create capacity – this should only be done before 
the semester has started.  However, this is the best possible solution as it allows the groups to 
remain at the desired capacity. 
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2. If you are making changes after locations have been allocated, change the planned size of your 
activity or activities but only up to the capacity of your location. 

3. If you still do not have enough capacity, you should then consider whether you should create an 
additional group, or request a larger room.  The decision will be based on other timetable 
commitments of the tutor, but you should also discuss this with the Timetabling & Room Bookings 
Team (if using Central Teaching Space) to find out the availability of rooms before you make the 
decision. 

Do not overload a group (or increase its planned size) beyond the capacity of the allocated room 
without informing the Timetabling & Room Bookings Team – a larger room will not automatically be 
allocated.  If you are making these changes before locations are allocated, you should change the 
planned size in order to be allocated a location with the correct capacity. 

If you wish to remove all of the students from their groups, click the Unallocate button.  To remove an 
individual student, double-click on the tick in their activity group column. 

 

 

Section 7: Making an ad hoc booking 

If you need to make a room booking that is not a teaching activity in a school-owned room, this can be 
done through S+. 

Please note: when making room bookings, you will be able to see the availability of Central Teaching 
Space rooms.  You should continue to make requests for these rooms via the Web Room Booking 
system, or by emailing timetable@leeds.ac.uk.  If you book an event into a Central Teaching Space room 
without permission, it will be removed. 

To make the booking process easier for you, the Timetabling & Room Bookings Team can add a location 
suitability linked to all of your school-owned rooms – you can then select this suitability, and the system 
will offer you only your own rooms for booking.  To request this, email timetable@leeds.ac.uk requesting 
a suitability called ZONE SchoolName(SO), containing your school-owned rooms. 

To make a booking 

1. From the Scheduling menu at the top of the screen select Location Booking.   

 

mailto:timetable@leeds.ac.uk
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2. New booking is selected by default (circled above). 

3. Change the name of the booking to the relevant name – this should start with the 4-letter code 
for your school (e.g. LUBS, HIST, etc.,), followed by the week number and then the detail of the 
activity e.g. HIST 19 Staff-Student Committee.  This makes bookings easier to find. 

4. Fill in the details of the booking: 

 Department – link this to your department. 

 Planned size – number of attendees at the event.  This will help you to ensure that a large 
enough location is selected.  If you have a specific room in mind you’ll need to ensure that 
the planned size relates to the capacity of the room in S+. 

 Description – enter the name & the phone extension of the person making the booking. 

 Type – this should always be IBK. 

 Duration – the length of the booking (remember in S+, a duration of 1 = 30 minutes). 

 Date - Select the date, either by entering the date in the date field, or clicking into the correct 
week in the week pattern bar and selecting a day on the grid. 

 Named Availability - If you are booking an event which takes place at the same day & time 
over a number of weeks you can select a Named Availability, or select the required weeks in 
the week pattern bar.  To do this, hold down the Ctrl key and click in the boxes for the 
relevant weeks. 

 Suitabilities – select any which are relevant but specifically your school-owned room 
suitability if this has been created.  Unless your school-owned rooms have had equipment 
(e.g. OHP, whiteboard, etc) added to their profiles, you don’t need to select anything else. 

 Click into a box on the timetable grid to choose your start time. 

 Available rooms, based on all the criteria you have selected, will appear in the Locations 
available to book box just to the left of the grid.  Click on a room in the list of locations. 

 Click the Book button (bottom right), followed by write-back to save the changes to the 
database. 

5. If you highlight a booking in the column on the left, S+ automatically selects Duplicate Booking.  
This allows you to make a copy of an existing booking and change the details.  With Duplicate 
Booking selected, change the name of the booking, and click Book.  You can then make any 
further changes and book your new event. 

6. If you need to change the details of an existing booking, select the booking in the column on the 
left and click Change Booking.  Any alterations you make will be applied to that booking once you 
have clicked Book. 


